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Computer Fundamentals ─ Overview 

Today’s world is an information-rich world and it has become a necessity for everyone to know about 
computers. A computer is an electronic data processing device, which accepts and stores data input, processes 
the data input, and generates the output in a required format. The purpose of this tutorial is to introduce you 
to Computers and its fundamentals. 

Functionalities of a Computer 

 If we look at it in a very broad sense, any digital computer carries out the following five functions: Step 1 - 
Takes data as input. Step 2 - Stores the data/instructions in its memory and uses them as required. Step 3 - 
Processes the data and converts it into useful information. Step 4 - Generates the output. Step 5 - Controls all 
the above four steps. 

Advantages of Computers 

Following are certain advantages of computers. High Speed  Computer is a very fast device.  It is capable of 
performing calculation of very large amount of data.  The computer has units of speed in microsecond, 
nanosecond, and even the picosecond. 

It can perform millions of calculations in a few seconds as compared to man who will spend many months to 
perform the same task. 

 Accuracy 

 In addition to being very fast, computers are very accurate.  The calculations are 100% error free.  
Computers perform all jobs with 100% accuracy provided that the input is correct. 

 Storage Capability 

Memory is a very important characteristic of computers.  A computer has much more storage capacity than 
human beings.  It can store large amount of data.  It can store any type of data such as images, videos, text, 
audio, etc. 

 Diligence 

 Unlike human beings, a computer is free from monotony, tiredness, and lack of concentration.  It can work 
continuously without any error and boredom.  It can perform repeated tasks with the same speed and 
accuracy. 



 Versatility 

 A computer is a very versatile machine.  A computer is very flexible in performing the jobs to be done.  This 
machine can be used to solve the problems related to various fields.  At one instance, it may be solving a 
complex scientific problem and the very next moment it may be playing a card game. 

 Reliability 

 A computer is a reliable machine. 
 Modern electronic components have long lives. 
 Computers are designed to make maintenance easy 

 Automation  

Computer is an automatic machine. 

Automation is the ability to perform a given task automatically. Once the computer receives a program i.e., 
the program is stored in the computer memory, then the program and instruction can control the program 
execution without human interaction.  

 Reduction in Paper Work and Cost 

The use of computers for data processing in an organization leads to reduction in paper work and results in 
speeding up the process. As data in electronic files can be retrieved as and when required, the problem of 
maintenance of large number of paper files gets reduced.  Though the initial investment for installing a 
computer is high, it substantially reduces the cost of each of its transaction. 

Disadvantages of Computers 

 Following are certain disadvantages of computers. 

  No I.Q. 

 A computer is a machine that has no intelligence to perform any task. 
 Each instruction has to be given to the computer. 
 A computer cannot take any decision on its own. 

  Dependency 

 It functions as per the user’s instruction, thus it is fully dependent on humans. 

 Environment 

The operating environment of the computer should be dust free and suitable. 



 No Feeling  

 Computers have no feelings or emotions. 
 It cannot make judgment based on feeling, taste, experience, and knowledge unlike humans. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



2. Computer Fundamentals ─ ApplicaƟons 
 

In this chapter, we will discuss the application of computers in various fields. 

Business 

A computer has high speed of calculation, diligence, accuracy, reliability, or versatility which has made it an 
integrated part in all business organizations. 

Computer is used in business organizations for: 

 Payroll calculations 
 Budgeting 
 Sales analysis 
 Financial forecasting 
 Managing employee database 
 Maintenance of stocks, etc. 

Banking  

Today, banking is almost totally dependent on computers. 

Banks provide the following facilities: 

 Online accounting facility, which includes checking current balance, making deposits and overdrafts, 
checking interest charges, shares, and trustee records. 

 ATM machines which are completely automated are making it even easier for customers to deal with 
banks. 

Insurance 

 Insurance companies are keeping all records upto-date with the help of computers.  Insurance companies, 
finance houses, and stock broking firms are widely using computers for their concerns. 

 Insurance companies are maintaining a database of all clients with information showing: 

Procedure to continue with policies 

 Starting date of the policies 

 Next due installment of a policy 



 Maturity date 

 Interests due 

 Survival benefits 

 Bonus 

Education 

The computer helps in providing a lot of facilities in the education system. 

 The computer provides a tool in the education system known as CBE (Computer Based Education). 
 CBE involves control, delivery, and evaluation of learning. 
 Computer education is rapidly increasing the graph of number of computer students. 
 There are a number of methods in which educational institutions can use a computer to educate the 

students. 
 It is used to prepare a database about performance of a student and analysis is carried out on this 

basis. 

Marketing 

In marketing, uses of the computer are following: 

 Advertising - With computers, advertising professionals create art and graphics, write and revise copy, 
and print and disseminate ads with the goal of selling more products. 

 Home Shopping - Home shopping has been made possible through the use of computerized catalogues 
that provide access to product information and permit direct entry of orders to be filled by the 
customers. 

Healthcare 

Computers have become an important part in hospitals, labs, and dispensaries. They are being used in 
hospitals to keep the record of patients and medicines. It is also used in scanning and diagnosing different 
diseases. ECG, EEG, ultrasounds and CT scans, etc. are also done by computerized machines. 

Following are some major fields of health care in which computers are used. 

 Diagnostic System - Computers are used to collect data and identify the cause of illness. 
 Lab-Diagnostic System - All tests can be done and the reports are prepared by computer. 
 Patient Monitoring System - These are used to check the patient's signs for abnormality such as in 

Cardiac Arrest, ECG, etc. 



 Pharma Information System - Computer is used to check drug labels, expiry dates, harmful side effects, 
etc. 

 Surgery - Nowadays, computers are also used in performing surgery. 

Engineering Design 

Computers are widely used for engineering purpose. 

One of the major areas is CAD (Computer Aided Design) that provides creation and modification of images. 
Some of the fields are: 

 Structural Engineering - Requires stress and strain analysis for design of ships, buildings, budgets, 
airplanes, etc. 

 Industrial Engineering - Computers deal with design, implementation, and improvement of integrated 
systems of people, materials, and equipment. 

 Architectural Engineering - Computers help in planning towns, designing buildings, determining a 
range of buildings on a site using both 2D and 3D drawings. 

Military 

Computers are largely used in defense. Modern tanks, missiles, weapons, etc. Military also employs 
computerized control systems. Some military areas where a computer has been used are: 

Missile Control 

Military Communication 

Military Operation and Planning 

Smart Weapons 

Communication 

Communication is a way to convey a message, an idea, a picture, or speech that is received and understood 
clearly and correctly by the person for whom it is meant. 

Some main areas in this category are: 

 E-mail 
 Chatting 
 Usenet 
 FTP 
 Telnet 



 Video-conferencing 

Government 

Computers play an important role in government services. 

Some major fields in this category are: 

 Budgets 
 Sales tax department 
 Income tax department 
 Computation of male/female ratio 
 Computerization of voters lists 
 Computerization of PAN card 
 Weather forecasting 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



3. Computer Fundamentals ─ GeneraƟons 
 

Generation in computer terminology is a change in technology a computer is/was being used. Initially, the 
generation term was used to distinguish between varying hardware technologies. Nowadays, generation 
includes both hardware and software, which together make up an entire computer system. 

There are five computer generations known till date. Each generation has been discussed in detail along with 
their time period and characteristics. In the following table, approximate dates against each generation have 
been mentioned, which are normally accepted.  

Following are the main five generations of computers. 

Sr. No. Generation & Description 

1 
First Generation: 
The period of first generation: 1946-1959. Vacuum tube based 

2 
Second Generation: 
The period of second generation: 1959-1965. Transistor based. 

3 
Third Generation: 
The period of third generation: 1965-1971. Integrated Circuit based. 

4 
Fourth Generation: 
The period of fourth generation: 1971-1980. VLSI microprocessor based 

5 
Fifth Generation: 
The period of fifth generation: 1980-onwards. ULSI microprocessor based 

 

 

 

 

 

 

 

 

 

 



4. Computer Fundamentals – Basics of Computer 

Hardware- The term hardware refers to the physical components of your computer such as the system unit, 
mouse, keyboard, monitor etc. 

Software- The software is the instructions that make the computer work. Software is held either on your 
computer’s hard disk, CD-ROM, DVD or on a diskette (floppy disk) and is loaded (i.e. copied) from the disk into 
the computers RAM (Random Access Memory), as and when required. 

Types of Computers 

 Mini and Mainframe Computers 

Very powerful, used by large organizations such as banks to control the entire business operation. Very expensive!  

 Personal Computers 

 Cheap and easy to use. Often used as stand-alone computers or in a network. May be connected to large 
mainframe computers within big companies. 

Hardware Components 

Input Devices -- "How to tell it what to do“  

- A keyboard and mouse are the standard way to interact with the computer. Other devices include joysticks and 
game pads used primarily for games. 
 

Output Devices -- "How it shows you what it is doing"  
 
- The monitor (the screen) is how the computer sends information back to you. A printer is also an output device. 

INPUT DEVICES: 

 The Mouse - Used to ‘drive’ Microsoft Windows 
 The Keyboard - The keyboard is still the commonest way of entering information into a computer 
 Tracker Balls - An alternative to the traditional mouse and often used by graphic designers 
 Scanners - A scanner allows you to scan printed material and convert it into a file format that may be used 

within the PC. 
 Touch Pads - A device that lays on the desktop and responds to pressure 
 Light Pens - Used to allow users to point to areas on a screen 
 Joysticks - Many games require a joystick for the proper playing of the game 

 



OUTPUT DEVICES: 

VDU - The computer screen is used for outputting information in an understandable format. 

 Printers -There are many different types of printers. In large organizations laser printers are most commonly 
used due to the fact that they can print very fast and give a very high quality output. 

 Plotters - A plotter is an output device similar to a printer, but normally allows you to print larger images. 
 Speakers - Enhances the value of educational and presentation products. 
 Speech Synthesisers - Gives you the ability to not only to display text on a monitor but also to read the text to 

you 

STORAGE DEVICES: 

"How it saves data and programs“  

Hard disk drives are an internal, higher capacity drive which also stores the operating system which runs when you 
power on the computer.  

"Floppy" disk drives allow you to save work on small disks and take the data with you. 

Hard Disks - Speed: Very fast!  

The speed of a hard disk is often quoted as "average access time" speed, measured in milliseconds. The smaller this 
number the faster the disk.  

Capacity: Enormous! 

Often 40/80 Gigabytes. A Gigabyte is equivalent to 1024 Megabytes. 

Cost: Hard disks costs are falling rapidly and normally represent the cheapest way of storing data. 

Diskettes (Floppy Disks)  

Speed: Very slow!  

Capacity: Normally 1.44 Mbytes. 

Cost: Very cheap 

CD-ROM Disks 

Speed: Bit slower than hard disks. The original CD-ROM speciation is given a value of 1x speed, and later, faster CD-
ROMs are quoted as a multiple of this value. 

Capacity: Around 650 Mbytes and more 

DVD Drives 

Speed: Much faster than CD-ROM drives but not as fast as hard disks. 



Capacity:Up to 17 Gbytes 

Cost: Slightly higher than CD-ROM drives. 

Memory -- "How the processor stores and uses immediate data 

RAM - Random Access Memory 

The main 'working' memory used by the computer. When the operating system loads from disk when you first switch on 
the computer, it is copied into RAM. As a rough rule, a Microsoft Windows based computer will operate faster if you 
install more RAM. Data and programs stored in RAM are volatile (i.e. the information is lost when you switch off the 
computer). 

ROM – Read Only Memory - As the name suggests is a special type of memory chip that holds software that can be read 
but not written to. A good example is the ROM-BIOS chip, which contains read only software. Often network cards and 
video cards also contain ROM chips. 

How Computer Memory Is Measured 

Bit - All computers work on a binary numbering system, i.e. they process data in ones or zeros. This 1 or 0 level of 
storage is called a bit.  

Byte - A byte consists of eight bits. 

Kilobyte - A kilobyte (KB) consists of 1024 bytes. 

Megabyte - A megabyte (MB) consists of 1024 kilobytes. 

Gigabyte - A gigabyte (GB) consists of 1024 megabytes. 

Microprocessors 

 "The brain of the computer“  

PCs primarily use microprocessors (sometimes called the chip). The older Intel versions include the 386, 486 and now 
the Pentium line. 

The CPU (Central Processing Unit) is normally an Intel Pentium (or equivalent) and it is one of the most important 
components within your computer. It determines how fast your computer will run and is measured by its MHz speed.  
Thus a 600 MHz Pentium is much faster than say a 400 MHz Pentium CPU. It is the CPU that performs all the calculations 
within the computer. 

Operating Systems Software: The operating system is a special type of program that loads automatically when you start 
your computer. The operating system allows you to use the advanced features of a modern computer without having to 
learn all the details of how the hardware works. The link between the hardware and you, the user makes the computer 
easy to use without having to understand bits and bytes! 



Applications software:  An application program is the type of program that you use once the operating system has been 
loaded. Examples include word-processing programs, spreadsheets and databases 

Information Network: 

LAN: A LAN (Local Area Network) is a system whereby individual PCs are connected together within a company or 
organization. 

WAN:  A WAN (Wide Area Network) as the name implies allows you to connect to other computers over a wider area 
(i.e. the whole world). 

Uses of Network: 

If ten people are working together within an office it makes sense for them all to be connected. 

 In this way the office can have a single printer and all ten people can print to it. 
 In a similar way other devices such as modems or scanners can be shared. 
 Even more useful is the ability to share information when connected to a network. 

 

---------------------------------------------------------------------------------------------------------------------------------- 



NOTE-PAD 

Notepad is a generic text editor included with all versions 

of Microsoft Windows that allows you to create, open, and read plaintext 

files. If the file contains special formatting or is not a plaintext file, it 

cannot be read in Notepad. The image shown here is a small example of 

what the Notepad may look like while running. 

 

How to open Notepad 

Users who are using Microsoft Windows can run Notepad (notepad.exe) 

by following the steps below. 

Step 1: On the windows desktop, find the windows Search Box. 

Step 2: In the Search Box, type notepad. 

Step 3: Click on the Notepad option in the search results. 

It will launch Windows Notepad application with untitled blank 

windows as shown in the picture. 

 

Title bar 

  

   The top most bar of the Notepad window is called the title   bar. 

   It opens with a name of Untitled - Notepad. 

 



Status bar 

The status bar in windows Notepad displays the current line number and 

column number of the cursor location. 

  

Menu bar 

The menu bar contains options of File, Edit, Format, View and Help tab. 

1. File tab 

File tab contains option of new page, Save, Save as, Print, Exit, Page 

setup etc. 

2.  Edit tab 

Edit tab contains options of Undo, Cut, Copy, Paste, Delete, Select all. 

Find, Find next, Replace etc. 

3.  Format tab 

Format tab contains Word Wrap and fonts of writing. 

4. View tab 

View tab contains option to enable or disable Status bar. 

 

How to create a text file using Notepad 

On the Windows dextop or in any folder, right-click an empty spot. In 

the pop-up menu, select New and then Text Document. After this is 

done, a file should appear named "New Text Document". Double-click 

this file to open the text document, or rename the file to help you 

identify it, and then open the file. 

https://www.computerhope.com/jargon/r/righclic.htm
https://www.computerhope.com/jargon/p/popupmen.htm
https://www.computerhope.com/jargon/r/rename.htm


How to insert a picture in Notepad? 

No. Notepad is a plaintext editor and does not support pictures. If you 

want to insert pictures, consider using WordPad instead of Notepad. 

Keep in mind that if a WordPad document contains pictures, it must be 

saved as an .RTF (rich text file), and not a .TXT (plain text file). 

How to change the font in Notepad? 

When first released, Notepad had no font options. However, with the 

new releases of Microsoft Windows, there are now font options that 

allow you to change the view of how text appears in Notepad. 

 In the menu bar at the top of the Notepad window, select Format, 

then select Font. 

 In the Font window, select the desired font in the Font list. 

 Additionally, you may select a style, like bold or italic, from 

the Font style list. You can also choose a different size for the text 

you type in the Size list. 

 When you've finished your selections, click OK to save the 

changes. 

How to center text in Notepad? 

No. Notepad is a plaintext editor and does not support the ability 

to center text, align text, or apply any other formatting. 

How do you print a Notepad document? 

 In Notepad, open the document you want to print. 

 In the file menu, click File, and select Print. 

 Select the printer that you want to use to print the document. 

 Click Print. 

https://www.computerhope.com/jargon/w/wordpad.htm
https://www.computerhope.com/jargon/m/menubar.htm
https://www.computerhope.com/jargon/b/bold.htm
https://www.computerhope.com/jargon/i/italic.htm
https://www.computerhope.com/jargon/c/center.htm
https://www.computerhope.com/jargon/a/alignment.htm
https://www.computerhope.com/jargon/f/format.htm
https://www.computerhope.com/jargon/m/menu.htm


 

Things to Remember 

 Notepad is a simple text editor for Microsoft windows. 

  It has been included since windows 1.0 in 1985. 

  .txt is the extension for notepad file. 

  Notepad has three bars, Title bar, Menu bar and Status bar. 

 Menu bar contains File, Edit and Format tab. 

 Notepad is a plaintext editor, and plaintext files don't support fonts. 

 You cannot change the view font color in Notepad. Only black is 

available for text. 

 

 

 

 

WordPad 

Introduction 

Microsoft WordPad is a free rich text editor and word processor, first 

included with Microsoft Windows 95 and all versions since. Although 
capable of doing more than Notepad, WordPad is not as advanced 

as Microsoft Word. Microsoft WordPad is a basic word processor that 

comes with windows. WordPad a program used to process format and 
store documents like letters, memo, reports curriculum vitae and many 



more. It is also capable of producing a print out of the end results. The 

WordPad file is saved with extension .rtf. But it is more advanced than 
Microsoft notepad. 

  

Steps to open WordPad in windows: 

 Click on the windows button in the lower left hand corner of the 

Desktop. 

 Click All programs, then Accessories, then click the WordPad 

 

  

WordPad Window:           

  

 Title bar: The title bar at the top of the window. On the right 

hand side of the title bar, we have three important control buttons, 

Minimize, Maximize (restore) and Cancel button. 

 Menu bar: The menu bar below the title bar of WordPad. It 

consist of following menus, File, Home and View menu button. 

 Toolbar: The toolbar is used for quick access. It contain some 

important tools used as short cut tools. These are like shortcut to 

New, Open, Save, Print, Print preview, Undo, Redo. 

 File Menu: This menu is used for functions like creating a new 

document, opening an already saved document, saving a 

document, printing and page set up. 



 Home Menu: This menu has a number of important groups like: 

Clipboard, Font, Paragraph, Insert and Editing. 

 The clipboard groups contain cut, copy, paste option. 

 The Font group contain font, Bold, Italic, Underline, 

Strikethrough, Subscript, Superscript, Text color, Text highlight 

color and some other functions. 

 The Paragraph group contains bullets, paragraph alignment, 

indent setting, line spacing options. 

 The Insert group contain inserting picture, paint drawing, Date 

and time and insert object options. 

 The editing group contains Find, Replace and Select all option. 

 View Menu: The view menu is used for viewing (displaying) the 

following: Zoom in, Zoom out, Ruler, Status bar, Word wrap and 

measurement unit. 

 

Open a File 

To open a previously saved file in WordPad - 

Click the File menu, and then click Open. 

 



 

Go to the location where you saved this file. 

Select the file, then click on the Open button. 

Save a File 

Click the File menu, and then click Save. 

 

 

Go to the location where you want to save this file. 

Type the name of this file and then click on the Save button. 

Page Setup 

This is where you can choose Page Size, Portrait or Landscape, Margins 

(Top, Bottom, Side), and Print Page Number. 

Click Page Setup in the File menu. 



 

 

Now a dialog box of Page Setup will open. 

You can select the paper size from the Size drop down. 

Apart from this you can set the page margin from here. Type the 

margins of left, right, top and bottom that you want. 

A) HOME TAB 

There are five groups in Home Tab: Clipboard, Font, Paragraph, Insert 

and Editing. 

1) Clipboard Group 

There are three options available in this group: Cut, Copy, Paste. 

 



 

i) Cut: With this option you can cut and paste selected text from one place to 

another. (Other options are: CTRL + X or right mouse click, Cut). 

ii) Copy: To copy the highlighted text and paste it elsewhere. (Other options are: 

CTRL + C or right mouse click, Copy). 

iii) Paste: You can either cut or copy the selected text and paste it 

elsewhere. (Other options are CTRL + V or right mouse click, Paste) 

2) Font Group: 

From font group you can apply selected font to many font style, such as - 

 

 

Font style: The default font is Calibri. Click on the arrow below for other font 

styles. 

Font size: The default font size is 12. Click on the arrow below for other font sizes. 

Pencil (Text Highlighter): 

You can use this highlighter to highlight selected text. You can choose from 12 

different colors by clicking the down arrow. 

3) Paragraph Group 

With this Paragraph group, you can format your Paragraph as follows- 



 

 

Decrease Indent: With this option, you can move bulleted or numbered text to the 

left of the page. 

Increase Indent: With this option, you can move bulleted or numbered text to the 

right of the page. 

Start a List: You can give the number or bullet for your list from here. 

Line Spacing: Use this option to set line space and indent. 

Left Align (CTRL + L): To start selected text from left 

Center Align: To bring the selected text to the center. (Another option is CTRL + 

E) 

Right Align: To align selected text to the right (another option is CTRL + R). 

Justified: The selected text is justified, meaning both left and right are 

aligned. (Another option is CTRL + J) 

4) Insert Group 

With the Insert group, you can add the following objects to your WordPad 

document: 

https://1.bp.blogspot.com/-r52y95hJ9G0/Xq6XXucSXnI/AAAAAAAAAQI/gVSp2SI73eUPur9fWQCDmq0IURxCIlzwQCLcBGAsYHQ/s1600/wordpad7.jpg


 

 

Picture: This is an option to insert an image into your WordPad document. After 

clicking on the Insert Picture button, select the path of your image and then click 

on the Open button below. 

Paint Drawing: You can insert the paint file you created in Microsoft 

Paint here. (Other options are CTRL + D) To change the size of an image, click on it 

and then click and drag on the square of the corner. 

Date and Time: From here you can insert current date / time in your WordPad 

document where the cursor is. 

Insert object: You can insert objects like graphs, text from other Microsoft 

packages from here. 

5) Editing Group 

The following options are available in this group - 

https://1.bp.blogspot.com/-PGr7b0SsUD8/Xq6XehzlOHI/AAAAAAAAAQM/W_1-Pr4qLpMdCYaQ3lDidyy9eYLM_JsxwCLcBGAsYHQ/s1600/wordpad8.jpg


 

 

Find: You can use this function to help quickly find a word in a 

document. (Another option is CTRL + F) 

Replace: Using this function, you can replace a word with another word in your 

document. (Another option is CTRL + H or Special Function Keys F5) 

Select All: This function selects all the text in the document. (Other options are 

CTRL + A) 

B) VIEW TAB 

The View tab has three groups: Zoom, Show or Hide, and Settings: 

 

 

https://1.bp.blogspot.com/-CKvzPUZkmzY/Xq6XqczKSiI/AAAAAAAAAQY/RoYsc_ayjyoR3gcrxvqiJMPc92fNJP9ngCLcBGAsYHQ/s1600/wordpad9.jpg
https://1.bp.blogspot.com/-xqVyxNHDwVo/Xq6X1tc4XpI/AAAAAAAAAQg/vnS5iWigdpQjnNyfJ8ZfMEYJwMSzIFUtQCLcBGAsYHQ/s1600/wordpad10.jpg


1) Zoom: 

Zoom in: You can enlarge your WordPad document by zooming in. 

Zoom out: You can view your WordPad document by zooming out and shrinking. 

100%: Click the 100% button to view the WordPad document in normal size. 

2) Show or Hide: 

With this group you can hide or unhide Ruler and Status bar. By default, the check 

boxes for Ruler and Status bar are selected, meaning you are visible. On 

unchecking these check boxes, they will get hidden. 

  

 

SOME KEYBOARD SHORTCUTS - 

WORDPAD  

Formatting  

Text Ctrl + B ⇒ Format the selection with Bold.  

Ctrl + I ⇒ Format the selection with Italics.  

Ctrl + U ⇒ Underscore (underlines) the selection.  

Ctrl + Shift + D ⇒ Double-underscore (underline) the selected text.  

Ctrl + Shift + W ⇒ Underscore (underline) only words (not spaces) of the selected 

text.  

Ctrl + = ⇒ Change the selected text to Subscript.  

Ctrl + Shift + = ⇒ Change the selected text to Superscript.  

Ctrl + D or Ctrl + Shift + F ⇒ select the text first, then press  



Ctrl + D to open the Front window  

Ctrl + Shift + A ⇒ Change the selected text to all CAPS. If text is already 

capitalized, will change to no CAPS.  

Ctrl + Shift + K ⇒ Change the selected text to small CAPS. If shortcut pressed 

again, will change to no CAPS.  

Working with Text  

Ctrl + C ⇒ Copy the selection to the Clipboard.  

Ctrl + V ⇒ Paste the selection from the Clipboard.  

Ctrl + X ⇒ cut the selection.  

Ctrl + Z or Alt + Backspace ⇒ undo the last action. Can be pressed multiple times 

to undo multiple actions.  

Ctrl + Y ⇒ Redo the last action.  

Ctrl + A ⇒ Select all text in the document.  

Ctrl + E ⇒ Center the text in the paragraph that the cursor is in, or center the 

selected text.  

Ctrl + L ⇒ Left align the text in the paragraph that the cursor is in, or left align the 

text in the selected text.  

Ctrl + R ⇒ Right align the text in the paragraph that the cursor is in, or right align 

the text in the selected text.  

Ctrl + J ⇒ justify the text in the paragraph that the cursor is in, or justifies the text 

in the selected text.  

Ctrl + M ⇒ indent the text. If no tabs are set, default indent is .5 inches. Press Ctrl 

+ M repeatedly to indent repeatedly.  

Ctrl + Shift + M ⇒ De-indent the text. Press Ctrl + Shift + M repeatedly to de-

indent  



Ctrl + K ⇒ insert a hyperlink - a link to a webpage.  

Alt + Shift + D ⇒ Enter the current date from your computer.  

Alt + Shift + T ⇒ Enter the current time from your computer.  

Working with a Document  

Ctrl + Home ⇒ Move to the beginning of the document.  

Ctrl + End ⇒ Move to the end of the document.  

Ctrl + F ⇒ Display the Find window.  

Ctrl + H ⇒ Open the Replace window.  

Ctrl + Enter ⇒ Insert a Page Break where the cursor is.  

Ctrl + S ⇒ Save the document. Get into the habit of pressing this key sequence 

often so you won't accidentally lose your work.  

Ctrl + P ⇒ Open the Print window.  

Ctrl + W or Alt + F4 ⇒ Close the document. Only Alt + F4 works in Microsoft 

WordPad.  

Ctrl + O ⇒ Open an existing document.  

Ctrl + N ⇒ Open a new document. 

 

 

Important points 

 Microsoft WordPad is capable of editing and saving plain-text file 

(.txt), rich text format (.rtf), Microsoft Word (.doc or .docx), and 

OpenDocument text (.odt) format files. 



Windows 95, Windows 98, Windows ME, and Windows XP does 

not support the .docx format. Windows 7 introduced the support of 

.odt files, so early versions of Windows do not support this format 

as well. 

 

 

 

 

 

 

MS-PAINT 

 

Introduction: 

Paint is a drawing tool. It is a part of Windows. You can use to create 

simple orelaborate drawings. These drawings can be either black-and-

white or color, and can be saved as bitmap files. You can print your 

drawing. You can also use it for creating your desktop background, or 

paste it into another document. You can even use paint to view and 

edit scanned photos. You can also use Paint to work with pictures, 

such as .jpg, .gif, or .bmp files. You can paste a Paint picture into 

another document you've created. The extension file name of Paint is 

.bmp. 



Steps to open MS-PAINT in windows: 

Choose Start > Search> Paint to open the main Paint Window. 

MS-PAINT Window:           

 

Title Bar: It is positioned top of windows. It shows the name of 

the application, document or File name. 

Menu Bar: It is positioned below the title bar. It contains File, 

Edit, View, Image, Options, and Help etc. 

Tool Box: It has 16 Tools like Pencil, Eraser, and Line Etc. We 

can you these tools for Drawing Something. 

Color Box: It has many Colors. You can you these Colors for your 

painting. 

Status Bar: It shows the status of our Mouse Pointer and other 

options. 

Scroll Bar: [Horizontal and Vertical] We used this option when 

the document does not fit in the window or Zoomed. 

Minimize Button: With the help of this option you can reduces 

the window to an icon and arranges it on the desktop. This option 

does not quit the application. 

Maximize Button: With the help of this option you can enlarges 

the active window so that it files the entire desktop. 



Close Button: This icon is used to close your current application 

windows. 

 

FILE MENU: 

 

New: The new command is used to create a new file document. 

Open: The open command is used to opens an existing document.   

Save: The save command is used to save the active document or the 

changes in the existing file. 

Save As: The Save As command is used to save the active document 

with a New name. 

Print Preview: The Print Preview command is used to Display the 

full pages. 

 Page Setup: The page setup command is used to change the page 

layout left, Right, Top and Bottom margins. 

Print: The print command is used to print the active document and 

sets printing options. 

Send: The send command is used to send a picture by using mailer 

box. 

Set As wallpaper [Tiled]: To set the active File on the desktop 

wallpaper as a tilled. 



Set As wallpaper [centered]: To set the active File on the desktop 

wallpaper in the Center. 

Exit: To Close the paint. 

 

Home Menu 

 

Undo: To undo the last action or step. 

Redo: To redo the previously undone action. 

Cut: To cut the selection from the active document and places it on 

the clipboard. 

Copy: To copy the selection and puts it on the clipboard. 

Paste: To Paste the cut or copied contents from clipboard. 

Clear Selection: To deletes the selection but it cannot be paste. 

Select All: To select the all text and graphics in the selected object. 

Paste From: This option is used to paste another file into the active 

file.  

Free From Select: It is used to selects a free from part of the picture 

to move, copy or edit.  

Select: It is used to selects a rectangular part of the picture to move, 

copy or edit.  



Eraser/Color Eraser: It is used to erase a portion of the picture using 

the selected eraser shape.  

Fill with color: It is used to fills an area with the current drawing 

color.  

Pick Color: It is use to pick up a color from the picture for drawing.  

Magnifier: It is used to the magnified the drawing.  

Pencil: It is used to draw a free hand drawing from line one pixel 

wide.  

Brush: It is used to draw drawings using a brush with the selected 

shape and size.  

Airbrush: It is used to draw airbrush drawings of the selected size.  

Text: It is used to inserts text into the picture.  

Line: It is used to draw a line with the selected line width.  

Curve: It is used to draw a curved line with the selected line width.  

Rectangle: It is used to draw a rectangle with the selected fill style. 

Polygon: It is used to draw a polygon with the selected fill style. 

Ellipse /Circle: It is used to draw an ellipse with the selected fill 

style. 

Rounded Rectangle: It is used to draw a rounded rectangle with the 

selected fill style. 

 



VIEW MENU: 

 

Zoom: 

Normal Size: To Zoom the picture to 100%. 

Large Size: To Zoom the picture to 400%. 

Custom: To Display the zooms size Like 100% to 800%. 

Show Grid: Shows or hides the grid lines on large size zoom. 

 

 

Shortcuts Keys 

Ctrl + N : New 

Ctrl + O : Open 

Ctrl + S : Save 

Ctrl + P : Print 

Ctrl + Z : Undo 

Ctrl + Y : Repeat/Redo 

Ctrl + X : Cut 

Ctrl + C : Copy 



Ctrl + V : Paste 

Ctrl + A : Select All 

Ctrl + T : Tool Box 

Ctrl + L : Color Box 

Ctrl + F : View Bitmap 

Ctrl + R : Flip/ Rotate 

Ctrl + W : Stretch/Skew 

Ctrl + I : Invert Colors 

Ctrl + E : Attributes 

Ctrl + Shift + N : Clear Image 

Alt + F4 : Exit 

Ctrl + Page Up : Normal Size 

Ctrl + Page Down : Large Size 

Alt + Space + R : Restore 

Alt + Space + M : Move 

Alt + Space + S : Size 

Alt + Space + N : Minimize 

Alt + Space + X : Maximize 

Alt + Space + C : Close 

 


